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C Introduction )

Kroy Limited Warranty

Kroy LLC (“Kroy”) warrants its labeling system equipment against defects in material and work-
manship for a period of six (6) months from the date of purchase. At no charge to the customer
except for inbound freight to Kroy’s service center, Kroy will, at Kroy’s option, repair or replace
any product determined to be defective. Kroy will pay return UPS ground charges. A purchase
receipt or other evidence of purchase will be required before warranty service is rendered. This
warranty does not cover cosmetic damage or any damage caused by accident, misuse, abuse,
negligence or modification or attempted repair by anyone other than Kroy or a Kroy authorized
repair agent. THERE ARE NO EXPRESS WARRANTIES EXCEPT AS SET FORTH IN THIS
PARAGRAPH.

KROY SHALL NOT BE LIABLE FOR ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES
FOR BREACH OF ANY EXPRESS OR IMPLIED WARRANTY ON THIS PRODUCT. ALL
EXPRESS AND IMPLIED WARRANTIES, INCLUDING WARRANTIES OF MERCHANTABILI-
TY AND FITNESS FOR A PARTICULAR PURPOSE ARE LIMITED TO THE APPLICABLE
WARRANTY PERIOD SET FORTH ABOVE.

Some states do no allow the exclusion or limitation of incidental or consequential damages, or
limitations on how long an implied warranty lasts, so the above exclusions or limitations may
not apply to you. This warranty gives you specific legal rights, and you may have other rights
which vary from state to state.

If a problem develops with your Kroy labeling system during or after this warranty period, you
may contact Kroy customer service at 800.729.5769.

FCC Notice

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to
part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful inter-
ference when the equipment is operated in a commercial environment. This equipment generates, uses and
can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual,
may cause harmful interference to radio communications. Operation of this equipment in a residential area is
likely to cause harmful interference in which case the user will be required to correct the interference at his
own expense.

Any changes or modifications not expressly approved by the manufacturer could void the user’s authority to
operate the equipment.

CDC Notice
This digital apparatus does not exceed Class A limits for radio noise for digital devices as set out in the radio
interference regulations of the Canadian Department of Communications.

Battery and AC Adapter Notice
This product is intended to be supplied by a Listed Power Unit AC adapter rated 12V DC, minimum 4.0A.

(OaC20)

CAUTION: (for Lithium Battery) Risk of explosion if battery is replaced by an incorrect type. Dispose of used
batteries according to the manufacturer’s instructions.

CAUTION: (for rechargeable Ni-Cd Batteries) Risk of explosion if batteries are replaced by an incorrect type.
Replace only with C size Ni-Cd batteries rated 1.2V maximum 2500 mAH. DO NOT USE ALKALINE
BATTERIES IN THIS PRODUCT.

The K5100 Printer and Cartridges are protected by U.S. Patents including: 5,411,339 5,533,818




Kroy - Caring for the Environment

Product Disposal Instructions

The symbol shown here and on the product means that the product is
classed as Electrical or Electronic Equipment and should not be disposed
of with other household or commercial waste at the end of its working life.

The Waste of Electrical & Electronic Equipment (WEEE) Directive
BN (2002/96/EC) has been put in to effect to recycle products using the best

available recovery and recycling processes to minimise the impact on the

environment, treat any hazardous substances and avoid increasing landfill.

Product Disposal Instructions for domestic / home users

When you have no further use for the product, please remove any batteries and dispose
of them and the product as per your local authority's recycling processes. For more
information please contact your local authority or the distributor / retailer from where the
product was purchased.

Product Disposal Instructions for business / commercial users

Business users should ensure that this product is not mixed with other commercial waste
for disposal. Please contact the distributor from where the product was purchased to
check the terms of your purchase contract.

Alternatively please contact Kroy Europe Ltd:

Tel: +44 (0)118 986 5200
Fax: +44 (0)118 986 5205
Email: info@kroyeurope.com

Kroy Europe Ltd WEEE Producer No.: WEE/KA0053TQ
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( Contents of Box

(1) K4100 Desktop Label Printer (1) Owner’s Manual and (1) CD-ROM
with KLDS Software and Drivers

(1) AC Adapter with Power Cord (1) Serial Cable



Printer Description )

Figure 1: Top View of Printer
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Important Safety Precautions

When using your printer, always follow these important safety
precautions:

Read all instructions carefully.

Do not immerse the printer in water or other liquids, you could receive an

electrical shock.

Do not apply adhesive labels to your skin.

Do not put objects onto or into the printer.

Do not expose to high temperatures or high humidity. Never leave on the

dashboard or in the trunk of your car.

Do not use in dusty places and avoid direct exposure to sunlight and rain.
Do not pull on the tape, you could damage the tape cartridge.

Do not attempt internal repairs to the printer. If service or repair is needed,
contact a qualified Kroy service representative.

Do not touch the printhead ceramic or rollers with your fingers.



Connecting AC Adapter

The AC adapter is required to power the K4100. Warning: Only use the AC
adapter provided with this machine. Use of any other AC adapter will dam-
age your K4100, make it unusable and void the warranty.

Connecting the AC Adapter

1. Insert the AC adapter plug into the AC adapter jack on the back of the
machine (See Figure 3).

2. Plug the other end of the AC adapter into the nearest standard electrical
outlet.

Figure 3: AC Adapter Connection

AC Adapter Jack

AC Adapter Plug

WARNING: K2500, K3000-PC and K240 AC adapters are NOT compatible
with the K4100.




Installing the Supply Cartridge

w

Figure 4: Installing the Supply Cartridge
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Wind the ribbon spool on the bottom of the supply cartridge counter-clock
wise two full turns in the direction of the arrow with your finger.

Insert cartridge into the cartridge cavity with the lock/release knob

turned counter-clockwise and the excess material threaded in the exit slot.
Turn the lock/release knob clockwise to lock the cartridge into place.
Press FEED and you are ready to create a label.
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Printing a Label

After you have connected the AC adapter, plugged the AC adapter into the
nearest outlet and installed the label cartridge, you are ready to make your first
label.

Turning the Printer On
Press the Power key located on the front left corner of the keyboard to turn
the printer on. The following displays will appear:

Kroy K4100 ] — [1:!

Version 1.0A 2:

Cursor Movement

The underline seen above is the cursor. The cursor shows you the current
typing position. Cursor keys move the cursor through text without changing it
and through options without selecting any. The left and right cursor keys move
left and right, one option or one character at a time; the up and down cursor
keys move the cursor up and down through lines of text, one line at a time.

Default Printer Settings

When the power is turned on for the first time, there are pre-programmed
printer settings. One of these is the Auto Size feature. This feature auto sizes
the text of your label to the current cartridge supply and size of media. You can
find this function by pressing the Size key. You can always turn auto sizing off
and type in a designated size, but for our example we will have auto sizing ON.
The default font is “Block”. No other font is installed on your K4100, however,
other fonts of your choice can be downloaded into your K4100. The default
justification is left. For more information on formatting and label setup see
Chapter 3.

In the following examples, we have kept the default settings ON.

Type in the text “Cable 2E45”

2:

1: Cable 2E45_ ]

Now that your label is typed, you will press the Print Key and the auto sizing
feature automatically sizes the text for the cartridge you are using.

Cable 2E45




To make a two line label, press Enter at the end of line 1 and you will see the
cursor go to line 2. Type in the text “Floor 2C” on line 2.

1: Cable 2E45

2: Floor 2C_

1: Cable 2E45_ ]
2:

Now that you have two lines typed, press the Print key and the auto sizing
feature automatically sizes the two lines for you.

Cable 2E45
Floor 2C

To add additional lines, perform the same function again.

Editing Text

You can correct or change characters by using the left and right cursor keys to
move the cursor to the right of the character to be changed. Use the Delete key
E=X to delete the character and type in the correction. Below we changed the
“E” on line 1 to “F” in our example.

Move the cursor to the right of “E” on line 1, press the Delete key and type in
the letter “F”.

1: Cable 2F45

1: Cable 2E45
2: Floor 2C

2: Floor 2C

Adding a Character Style

You can change the style of text previously entered by using the left and right
cursor keys to position the cursor to the beginning of your text. Press the Style
key to select your character style of choice. To turn styles on and off use your
Enter key.

In the following example, the cursor is moved to the beginning of the word
“Floor” and Bold was then selected in the Style Menu. Note: Only text to the
right of the cursor will be changed.

1: Cable 2F45
2: Floor 2C

Style Menu
B Rotate *Bold _ltalic

Now that your label has been edited and styled press the Print Key.

Cable 2F45
Floor 2C
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Printing on Shrink Tube )

Kroy offers flattened shrink tube cartridges for wire marking. Insert a shrink tube
cartridge for this example.

You will start with a New file. To create a New file, press the File
key and select New with the Enter key. Or use Shift and File as a shortcut.

For our example, we kept Auto Size ON.

Type in the following text “File Server”

1: File Server_
2:

Press the Print key. Cut the shrink tube label and insert the wire.

@File Server C:O

The tubing can be shrunk around the wire with a heat gun.

For further information on formatting the text of your shrink tube See Chapter 3.

1



C Printing a Self-Laminating Wire Wrap

Kroy offers self-laminating wire wrap cartridges ideal for marking terminated
wires and cables. Insert a self-laminating wire wrap cartridge for this example.

For our example, we kept Auto Size ON.

You will start with a New file. To create a New file, press the File key and select
New with the Enter key. Or use Shift and File as a shortcut. When using a wire
wrap cartridge, this will activate the automatic rotation feature. Rotation is nec-
essary because the printable area of a wire wrap is vertical and represents a
small portion of the label.

Type in the following text “300E”

1: 300E_
2:

Press the Print key then Feed and you have a wire wrap ready to apply.

NN
N

AN
N

300E

Apply the printed portion of the label to your wire and wrap the laminated tail
around the wire.

/

/

For further information on formatting the text of your wire wrap See Chapter 3.
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Frequently Used Keys

The keyboard is used to enter label text and access menus. You will hear an
audible click whenever a key is depressed. The frequently used keys on the
keyboard are described below.

Function keys (File, Font, Size, Style, Repeat), will automatically prompt a list
of selections to choose from. When using some function keys, the printer will
display submenus or prompt you for information. These function keys also act
as “toggles” which allow you to turn an option on or off.

The Alt Key accesses special character symbols shown in blue on particular
keys. To enter a special character, (such as A), hold down ALT and press the
key of choice at the same time. To abort a print job, use the Alt and the Print
keys together.

The Cursor (Arrow) Keys move the cursor through text without changing it and
through options without selecting any. The left and right Cursor keys move left
and right, one option or one character at a time; the up and down Cursor keys
move up and down through lines of text, one line at a time. When used with
SHIFT, the up and down Cursor keys act as Page up (previous label) and
Page Down (next label) keys and the left and right Cursor keys move the cur-
sor one word at a time.

The Caps Key locks capital letters on. Pressing the Caps key again turns off
the function. The Caps key does not effect the number keys.

The EE1 Delete Key allows you to cancel functions or escape from menus.
Delete erases characters to the left of the cursor. To Delete an entire line, hold
down Shift and the Delete key together.

The Enter Key in typing mode, moves the text or the cursor to the next line. In
function mode, the Enter key selects specific menu options, file names and
default printer settings.

The Feed Key advances the tape from the printer.

The Print Key prints the current label and advances the tape far enough to
clear the cut mechanism.

The Shift Key capitalizes individual letters and accesses the black characters
on the number keys (such as !). Using the Shift and File key creates it clears
text allowing you to create a new label.

13
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Font Function )

Using the Font Menu
When you select the Font key the printer displays the default “Block” font seen
below. This is the only font included with the K4100.

Font Menu
B Block

K4100 has the option of downloading fonts from your PC. When you download
a font, it will be added to your Font menu.

B Block _times _arial

Font Menu ]

Press Enter to accept the current Block font or use the left and right cursor keys
to move the cursor to the left of the font you want and press Enter to select it.

See Downloading Fonts on Pages 41-42 for further information.

15



Size Function

Using the Size Menu

Select Size to specify the print size for your text. The printer displays the default
Auto Size function and waits for your entry. Press Delete to accept auto sizing
or type a different size and press Enter. Valid sizes of 4-72 pt can be entered.

Size Menu Auto Size OFF
Size B 24 *Auto

When printing, the K4100 will show what point size is being printed in the auto
size mode. See below.

Auto Size xx pt

Printing..... ]

If you select Auto Size, the K4100 will automatically adjust the print size based
on the number of lines of your label and the width of the label media. If you turn
auto size off, the size of the print you select must take into account the number
of lines of your label and the width of the media.

If auto size calculates a point size smaller
Error . i
. than 4 point, an error message will be
Size Too Small .
displayed.
Error If the text you have typed is too large, an
FontSize Too Big error message wil be displayed.

See the table below which can be used as a guide. The table assumes using
characters of all the same size (capital letters). When using characters of vary-
ing size (such as lower case letters or accent characters) or using character
styles (such as bold, italic etc.) the maximum point sizes will vary slightly.

Tape Size| 1 Line 2 Line 3 Line 4 Line 5 Line 6 Line
0.375” 28 pt 11 pt 8 pt N/A N/A N/A
0.50” 38 pt 19 pt 12 pt 8 pt N/A N/A
0.80” 60 pt 30 pt 20 pt 15 pt 11 pt N/A

1” 72 pt 36 pt 24 pt 18 pt 14 pt 12 pt

16



Character Styles

This section explains how to use the Style key to assign text formatting attrib-
utes to your label text. There are three types of text attributes: character, line
and page. These attributes, as well as their defaults and options, are shown in
the following table.

Attribute Defaults Options
Download True Type
Font Block Fonts from PC
.50” 4-30 point size
Size Auto Size On .80” 4-55 point size
17 4-72 point size
Justification T Left Left, Center, Right
*Bold Off On, Off
*Italic Off On, Off
*Mirror off On, Off
*Vertical 1 off On, Off
Off Page: On, Off
*Frame
Off Line: On, Off
*Underline Off On, Off
Rotate 1 off On, Off

* Attributes marked with a asterisk are toggles. T are line attributes. They affect
the entire line of text that the cursor is positioned on. 1 are page attributes.
They affect the entire page (label). All other attributes (except Frame) are char-
acter attributes only and affect the text from the point that the cursor is posi-
tioned.

The following style settings are available on the K4100: Rotate, Bold, Italic,
Underline, Justify, Mirror, Frame and Vertical.

To Select Multiple Styles, with less keystrokes, use the Space Bar and the
cursor keys to turn styles on and off. For more Shortcuts, See page 24.

Note: When the Style menu is selected, all selections are not visible on the
LCD display - you will have to use your left and right cursor keys to scroll
through all the choices.

17



The most common character styles used are Bold, /falic and Underline.

To emphasize the text of your label using Bold, move the cursor to the position
where you want to apply the Bold attribute and press the Style key. Use the left
and right cursor keys to move the cursor to the left of Bold and press Enter.
When turned on, an asterisk will appear. To turn Bold off, press Enter again or
to exit press Delete.

1: ATTENTION Style Menu
2: B Rotate *Bold _ltalic
Bold Example:

ATTENTION

To italicize the text of your label using Italic, move the cursor to the position
where you want to apply the ltalic attribute and press the Style key. Use the left
and right cursor keys to move the cursor to the left of Italic and press Enter.
When turned on, an asterisk will appear. To turn ltalic off, press Enter again or
to exit press Delete.

Style Menu

1: ATTENTION
B Rotate _Bold xltalic

2:

Italic Example:.

ATTENTION

To underline the text of your label using Underline, move the cursor to the posi-
tion where you want to apply the Underline attribute and press the Style key.
Use the left and right cursor keys to move the cursor to the left of Underline
and press Enter. When turned on, an asterisk will appear. To turn Underline
off, press Enter again or to exit press Delete.

Style Menu

1: ATTENTION
_ * Underline _Justify

2:

Underline Example:

ATTENTION

18



Other Styles )

Other character styles include Mirror, Frame, Justify, Vertical and Rotate.

To reverse the text of your label using Mirror press the Style key. Use the left
and right cursor keys to move the cursor to the left of Mirror and press Enter.
When turned on, an asterisk will appear. To turn Mirror off press Enter again or
to exit press Delete. When using mirror image, use clear tape for best results.

1: ATTENTION Style Menu
2: * Mirror _Frame

Mirror Example:

NOITUITTA

To draw a box around the text of your label using Frame press the Style key.
Use the left and right cursor keys to move the cursor to the left of Frame and
press Enter. When turned on, an asterisk will appear. The printer displays the
frame menu and waits for you to select the type of frame you want. To turn
Frame off, press Enter again or to exit press Delete.

Style Menu
_ Mirror *Frame

Once Frame is selected, the Frame Menu will appear. To frame all the text on
the label, select Page by pressing the Enter key. When turned on, an asterisk
will appear

1: ATTENTION Frame Menu
2: EMPLOYEES * Page _Line

Page Frame Example:

ATTENTION
EMPLOYEES

19



To frame just a line of text, move the cursor to the line of your text and select
Line by pressing the Enter key. When turned on, an asterisk will appear

1: ATTENTION Frame Menu
2: EMPLOYEES _ Page *Line

Line Frame Example:

[ATTENTION]
EMPLOYEES

To justify the text of your label using Justify press the Style key. Use the left
and right cursor keys to move the cursor to the left of Justify and press Enter.
The printer displays the justify menu and waits for you to select the justification
of your choice. To exit the Justify menu press Enter or the Delete key. Note:
The default justification is lefft.

Justify Menu

* Left _Center _Right

1: ATTENTION
2: PLEASE

Left Justification

ATTENTION
PLEASE

Center Justification

ATTENTION
PLEASE

Right Justification

ATTENTION
PLEASE

20



To print the text of your label vertically instead of horizontally using Vertical,
press the Style key. Use the left and right cursor keys to move the cursor to the
left of Vertical and press Enter. When turned on, an asterisk will appear. To
turn Vertical off press Enter again or to exit press Delete.

1: ATTENTION

Style Menu
2:

* Vertical _Rotate

Vertical Example:

<|—-—WZF—-02Z2

To rotate the text of your label using Rotate, press the Style key. Use the left
and right cursor keys to move the cursor to the left of Rotate and press Enter.
When turned on, an asterisk will appear.To turn Rotate off, press Enter again or
to exit press Delete.

Rotation and Vertical are not the same. Note: Mirror is ignored when rotation is
selected.

1: 300E_ Style Menu
2: * Rotate _Bold

Rotate Example:

N\
AN

AN
N\

300E

Auto Rotation
When a self-laminating wire wrap cartridge is installed, the K4100 will automati-
cally rotate and auto size the text using the instructions below.

You will start with a New file. To create a New file, press the File key and select
New with the Enter key. Or use Shift and File as a shortcut. This will activate
the auto rotation feature.

21



( Label Setup

To select the Label Setup press the Shift and the Style key together. The

prompt below will appear. The menu options are length, cutmark, left margin
and vertical margin.

Label Setup
B Length _Cutmark

In the default setting, the Length of a printed label automatically adjusts to fit
the length of text. If you want to specify the length of a label, the Length func-
tion allows you to set the length between 0.3” and 20”. To turn Auto off, type in
your specific length and press Enter. To exit the length menu without making
any changes press Delete.

Lenm 0.3 *Auto

Length Menu 1

The Cutmark function creates cutmarks along a print job. Use the left and right
cursor keys to move the cursor to the left of Cutmark and press Enter. When
turned on, an asterisk will appear. To turn Cutmark off press Enter again or to
exit the menu without making any changes press Delete.

Label Setup Room 5 Room 6
B Length xCutmark | Floor ZCI | Floor ZCI

The Left margin function allows you to increase the size of your left margin by
moving text from the left to the right of your label. The amount is measured in
pixels. Use the left and right cursor keys to move the cursor to the left of
Leftmargin and press Enter. A prompt will appear. Use the right and left cursor
keys to select an increment up to 30 pixels. Press Enter to select the increment
of choice. See the example below.

This function is used with die cut labels and self-laminating wire wraps only.

% 4 /| The text seen here
o9 has printed right :
% © |/ 4| tothe edge. . Left Margin
Sl%) Margin: ®m+5
L
o V7
00
ol The text is now adjusted.
Q|7 7
[©]))]

22



The Vertical margin function allows you to move text from the top to the bottom
by pixel on your label. Use the left and right cursor keys to move the cursor to
the left of Vertmargin and press Enter. A prompt will appear below. Use the
right and left cursor key to select an increment up to 30 pixels. Press Enter to
select the increment of choice. See the example below.

ATTENTION
EMPLOYEES

Vert Margin
Margin: m+2

The text seen here has printed to
the bottom of the label.

ATTENTION
EMPLOYEES

The text is now adjusted upward on the label.

23



Shortcuts and Hot Keys

A Shortcut will provide a direct route to some submenus and options. See the
listing below. To use a shortcut, first press and hold the Shift or Alt key and
then press the second key.

Shift + File Creates a New File / Erases All Text
Shift + Font Bar Code Menu

Shift + Size Toggle Auto Size On/Off

Shift + Style Label Setup

Alt + Style All Styles Reset

Shift + Repeat Time/Date Menu

Shift + Print Printer Setup

Alt + Print Stops Print Job

Shift + Delete Erase Current Line

The Space Bar can be used to select multiple items on a menu. For example,
in the Style Menu, if you want Bold and Italic on at the same time simply use
your cursor key and the Space Bar to select these options and then exit the
menu using the Delete key.

Hot keys are represented by a capitalized letter in most function key menus (i.e.
_New _Open _Save). For example, the File Menu is selected. By pressing the
letter “N”, a new file will be selected without using the cursor keys and the enter
key. Hot keys turn menu options on and off. And they also act as a shortcut to
submenus. Note: The function key must be selected first before using the hot
key. Hot keys work only in function mode.

Below is a listing of some of the function menu’s hot keys.

File Menu Hot Keys
“N” New File

“O” Open File Menu
“S” Save File Menu

Size Menu Hot Keys
“A” Auto Size On/Off

Style Menu Hot Keys

“R” Rotate On/Off
“B” Bold On/Off

“I” ltalic On/Off

“U” Underline On/Off

24

“J” Justify Menu

“L” Left Justify On/Off
“C” Center Justify On/Off
“R” Right Justify On/Off
“M” Mirror On/Off

“F’ Frame On/Off

“V” Vertical On/Off

Repeat Menu Hot Keys

“S” Sequence Menu

‘I’ Insert

“A” Alpha On/Off - Sequence Start/End
“N” Numeric On/Off - Sequence Start/End



Multiple Copies and Sequencing

)

This section explains how to use the Repeat key to print multiple copies
of a file or sequence text either numerically or alphabetically.

Press the Repeat key to make copies or sequence labels. The prompt below
will appear.

Repeat Menu
B Sequence _Copies

Select Copies to specify the number of copies you want to print (1-999). Use
the left and right cursor keys to move the cursor to the left of Copies and press
Enter. The printer displays the current setting for this option (see the following
example) and waits for your entry. Press Delete to accept the number of copies
shown, or type in your specific number and press Enter. Press Print.

Copies Menu
Copies: B2

Select Sequence to automatically generate and print labels containing a
sequence of one letter or one to three numbers (101 102 103, ABC....etc.) with-
out having to type the text of each label yourself. You simply tell the printer what
characters to print on the first and last labels an how much to increment
between labels (see following table).

Printing Sequential Labels

Start Stop Increment Individual Labels Printed
1 10 1 12345678910
01 10 1 01 02 03 04 05 06 07 08 09 10
001 10 1 001 002 003 004 005 006 007 008 009 010
2 12 2 24681012
A J 1 ABCDEFGHIJ
a z 4 aeimquy

The sequence character takes on the current character attributes previously defined.
Optionally, you can redefine the sequence character’s attributes like any other char-
acter. Note: You can only define one sequence type (numeric or alpha) per docu-
ment/file, but you can place the sequence character in your document/file once on
each line.
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Select Sequence from the Repeat menu. The Sequence menu will appear.

Sequence Menu
B Insert *Alpha _Num

Use the left and right cursor keys to move to the left of the option you want and
press Enter to select it.

Example 1

If you choose Alphabetic, the printer prompts you to enter the first letter to start
the sequence. Type the first letter of your choice and press Enter.

For our example, we have selected the letter “A”.

Sequence Start
Start: B A

The printer then prompts you to enter the last letter to end the sequence. Type
the last letter of your choice and press Enter.

Sequence End
End: mC

The next prompt you will enter the increment amount. Press Enter.

Inc: B 1

Sequence Inc ]

You will then select Insert from the Sequence menu by pressing Enter. This
will place the sequence where you would like it to begin. A black box will be
seen where the sequence will start. See example below.

F—

Press the Print key.

Wire A Wire B Wire C
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For multiple labels, Press the Repeat key and the Repeat menu will appear.
Toggle your cursor to the left of Copies and press Enter to select.

_Sequence E Copies

Repeat Menu ]

The number of copies can either be typed in or you can use your up and down
cursor keys. In our example, we have selected 2 copies. Press Enter.

Copies Menu
Copies: m2

Press the Print key.

Wire A Wire A Wire B Wire B

Example 2

If you choose Numeric, the printer prompts you to enter the first number to start
the sequence. Type the first number of your choice and press Enter.

For our example we have selected two digits.

Sequence Start
Start: m06

Enter the last number to end the sequence. Type the last number of your
choice and press Enter.

End: m12

Sequence End ]

The next prompt you will enter the increment amount. Press Enter.

Sequence Inc
Inc: B2

You will then select Insert from the Sequence menu by pressing Enter.
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A black box will be seen where the sequence will start.

1: Al
2:

Press the Print key.

AO6 A08 A10 A12

Example 3

Here is another example of a numeric sequence using an increment of 2 and triple
digits.

Enter the first number to start the sequence. We chose “006” for this example.
Press Enter.

Sequence Start
Start: 006

Enter the last number to end the sequence. We chose “12” for this example.
Press Enter.

Sequence End
End: m12

The next prompt you will enter the increment amount. Press Enter.

Sequence Inc
Inc: B2

You will then select Insert from the Sequence menu by pressing Enter.
A black box will be seen where the sequence will start.

1:0
2:
Press the Print key.

006 008 010 012
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Example 4

Here is an example of using multiple pages and numeric sequencing. For our
example, we have typed “Line In” on the label (Page 1).

1:Line In_
2:

Press the Repeat key and select Sequence by pressing Enter. Toggle the cursor
to the left of Numeric and press Enter again.

Sequence Menu
B Insert _Alpha *Num

Enter the first number to start the sequence. We chose “1” for this example.
Press Enter.

Start: 11

Sequence Start ]

Enter the last number to end the sequence. We chose “2” for this example.
Press Enter.

End: m2

Sequence End ]

The next prompt you will enter the increment amount. Press Enter.

Inc: =1

Sequence Inc ]

You will then select Insert from the Sequence menu by pressing Enter.
A black box will be seen where the sequence will start.

2:

1:LineInk ]

continued on page 30
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To start a new page, use the Shift and the Down Cursor key to move to the
next page. A prompt will appear with the page number.

e

We have typed “Line Out” on the label (Page 2).

1: Line Out_
2:

Follow the same steps for the sequence setup on Page 1 and Insert the
sequence. A black box will be seen where the sequence will start.

2:

1: Line Out ]

Press the Print key.

Line In 1 Line Out 1 Line In2 Line Out 2
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Printer Setup )

To select the Printer Setup press the Shift and the Print key together. The
prompt below will appear. The menu options are reset, unit of measure, density,
auto off, advance cut, language, printspeed and Icd contrast.

Printer Setup
B Reset _Unit _Density

Select Reset to restore all factory settings and defaults. To select Reset press
Enter or to exit press Delete.

i |

The Unit of Measure function allows you to choose the unit of measure you
want to use for setting label width and margin. The options are tenths of an inch
(default) and millimeters. Select Unit from the printer setup menu by using the
cursor keys and pressing Enter. The unit menu will appear. Use the arrow keys
to move to the left of the option you want and press Enter.To accept the current
setting press Delete.

Unit Menu
B *Inch _MM

Select Density to specify the density (0-7) for printing the current label. Density
will make the label darker or lighter per unit measure. The printer displays the
current density setting and waits for your entry. Press Delete to accept the
value shown, or use the left cursor key to add density and press Enter.

D: #4441

Density Menu ]

If the characters are smeared on a label or are not completely filled in, you can
attempt to fix the problem by adjusting the print density. If the characters are
smeared, specify a lower number in the field; if the characters are not complete-
ly filled in, specify a higher number. You may need to adjust the density after
installing a new tape.
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Select Auto Off to activate auto shut off. The factory default is to shut off the
printer after 5 minutes of non-use. When the printer is turned off, all current
label text and text attributes settings are saved. All files in memory are still
saved. Press Delete if you decide you do not wish to change the current set-
ting. Or press Enter to activate auto shut off. When turned on, an asterisk will
appear. By default, this function is on.

The Advance to Cut function advances the label material to the cut position.

The default setting is advance to cut enabled. If you do not need this function

you may disable the advance to cut function by using the cursor keys to move
to the left of Advance in the printer setup menu and press Enter.

The Language function allows you to choose from 4 different languages. The
default language is English. Other options are spanish, french and german.
Select Language from the printer setup menu by using the cursor keys and
press Enter. The language menu will appear. Use the cursor keys to move to
the left of the language you want and press Enter. To accept the current setting
press Delete.

Languages Menu
* English _eSpanoL _Francai _Deutsch

Printspeed is the rate at which the label advances from the printer when print-
ed.The default printspeed is unlimited. To specify a printspeed, select PrtSpeed
from the printer setup menu by using your cursor keys and press Enter. The
printspeed menu will appear and by using your cursor keys you can select from
the options below by pressing Enter. To accept the current setting press Delete.

* Unlimit _0.5_0.8 _1.0

PrtSpeed Menu ]

The LCD Contrast allows you to lighten or darken the LCD of your printer.
Select Ledcontrast from the printer setup menu by using the cursor keys and
press Enter. The Icd contrast menu will appear. Use the right cursor to lighten
or the left cursor to darken. As you use the cursors, you will see a difference in
your screen. Press Enter to accept the your setting. To accept the current
setting press Delete.

LCD Contrast
Use Left - Right
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Bar Codes

To print a Bar Code, press the Shift and the Font key together. Use the Bar
Code Menu to specify the type of bar code you want to print.

BARCODE Menu
B None _codaBar _Code39 _Ean8 _eAni13 _I20f5

BARCODE Menu
_Upca _uPce _coDe128 _Msiplessey _pdF417

K4100 has ten bar codes built-in. The following table summarizes information
on these bar codes.The

Bar Code Valid cge‘t:ilzsnusm Fixed Special Restrictions
Type Characters Av’;ilable Length & Other Information
First and last characters
0-9 A-D None, mod 10, <32 must always be either A,
Codabar -$/+% mod 16 characters | B, C, or D. Letters not allowed
in body of bar code
09 A-Z <32
Code 39 Sp :Cg +% None, mod 43 characters Lowercase letters not allowed
7,90r12 Length varies because of
- 0-9 - '
EAN-8 EAN-8 digits optional 2 or 5 digit supplemental
12, 14 or 17 |Length varies because of
- 0-9 - » g
EAN-13 EAN-13 digits optional 2 or 5 digit supplemental
Interleaved 0-9 None. mod 10 | Even number | Printer adds leading zero, if
20of5 ' of digits needed, to make the length even
11,13 or 16 |Length varies because of
UPC-A 0-9 None digits optional 2 or 5 digit supplemental
6,8 0r 11 Length varies because of
UPC-E 0-9 None digits optional 2 or 5 digit supplemental
128 ASCII <32 :
Code 128 Character Set None characters See Appendix D
None, mod 10, | <16 Mode 11 checksum cannot
msI Plessey 0-9 mod 11 characters |equal 10
Al ASCII 0 to 400 levels | <700
PDF 417 characters of security characters | None

After the bar code selection has been made, press the Shift and Font keys
together to go back to the Bar Code menu. The menu will change allowing you
to customize the bar code selected using code, text and resolution.

BARCODE Menu
B Code _Text _Resolution




Select Code to change the type of bar code you want to print. The printer dis-
plays the types of bar codes available. Use the left and right cursor keys to
move to the left of the option you want and press Enter. If an asterisk displays
to the left of the option, selecting it turns code off.

Depending on the bar code you have selected, some bar codes allow you to
choose whether to include a checksum and change the resolution at which the
bar code is printed as well as whether to print text or the checksum.

Select Text to print text as part of the bar code. Use the left and right cursor
keys to move to the left of the option you want and press Enter. If an asterisk
displays to the left of the option, selecting it turns text printing off. Text is printed
in the following manner:

¢ Code 39, Code 128, Interleaved 2 of 5 and MSI Plessey: text is printed
immediately beneath the symbol.

* EAN8, EAN13 and UPC: text for the number system is printed at the left
of the symbol; text for the product and manufacturer code is printed
beneath the symbol; text for the supplemental is drawn above
the symbol.

* PDF 417 has no text option.
Resolution specifies whether you want to print the bar code at normal or high

resolution. Use the left and right cursor keys to select the option you want and
press Enter.

Resolution Menu
* Medium _High

CheckSum specifies the type of error checking you want to use. The type of
bar code selected at Code determines the prompt that displays next. For
example, if you selected 12 of 5, the following prompt displays:

BARCODE CheckSum
* Mod10 _Mod16

Some bar code symbologies allow you to print the checksum value as part of
the bar code
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File Management

To select the File Menu press the File key. Use the File Menu to create new
files, open files, save files and delete files.

ENew_Open_Save_Delete

File Menu ]

Select New to create a new document. The printer clears any text displayed on
the screen, returns all attributes to factory defaults and displays a blank edit
screen so you can enter new text. To create a New file, press the File key and
select New with the Enter key. Or use Shift and File as a shortcut.

i |

Select Open to access an existing document you want to edit or print. The
printer displays a list of file(s) you have saved (see the following example) and
waits for you to select the file you want to work with. Press the File key and use
the cursors to scroll to the left of Open and press Enter. The Open File Menu
is now displayed. Use the left and right cursor keys to scroll to the left of the file
want to open and press Enter to select it. See example below.

Open File Menu
B Address _Job 4048 _ww

Select Save to save the current document. You must save the label you are
working on before you select either New or Open. If you do not save first, it will
be lost. Press the File key and use the cursors to scroll to the left of Save and
press Enter. The Save File Menu is now displayed prompts you to enter a file
name..

[ Save File Menu ]
|

File names can be any combination of letters and numbers, 8 character maxi-
mum, with no punctuation or file name extensions.
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If you enter a file name for an already existing file, you will see the following
message:

Overwrite?
OK? (Y,N)

Press Y to overwrite or N to enter a different file name. If you decide not to save
the file, simply press Delete.

Select Delete to delete files that you no longer need. Press the File key and
use the cursors to scroll to the left of Delete and press Enter. The Delete File
menu displays a list of files you have saved (see the following example) and
waits for you to select the file you want to delete. Use the left and right cursor
keys to move the cursor to the left of the file you want to delete and press Enter
to select it. If you decide not to delete a file, simply press Delete.

Delete File
B Address _Job 4048 _ww
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Multiple Page Documents

You can enter multiple labels in a file by using Page Up an Page Down

to access additional pages (labels). In this case, you can think of a file as a sin-
gle document containing one or more pages (labels). Each label can be up to
six lines.

1:1
2:

To start a new page while you are in a file, use the Shift and the Down Cursor
key to move to the next page. A prompt will appear with the page number.

Page 2

To move back to the preceding page, use Shift and the Up Cursor key. When
you press the Print key, all pages in the file will be printed.
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Time/Date Stamp

To select the Time/Date Menu press the Shift and Repeat keys together. Use
the Time/Date Menu to print labels with

Time/Date Menu
B Time _datE _stamP _setclOck _24Hourmode

To use the Time/Date functions you must first set the real time clock with
the local time and date. This will lock the time and date into memory. This will
have to be done once with the exception of summer and winter time changes.

Select Set Clock to enter the current time and date in the printer. Use the cur-
sor keys to scroll to the left of Set Clock and press Enter. The prompt below
will appear. Use the Up and Down cursor keys to scroll through the menu.

The information will be entered in the order shown here:

Year_
Month_
Day_
Hour_
Minute_
Second_

Set Clock Parameters

Prompt |Parameters

Year Last two digits of the year

Month Number from 1 to 12

Day Number from 1 to 31

Hour* Number from 0 to 23

Minute Number from 0 to 59

Second | Number from 0 to 59

* Hour is entered in 24 hour mode (i.e. 1PM would be entered as 13)
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Select Time to add the current time to your label. Use the cursor keys to scroll
to the left of Time and press Enter. The time will be added to the label where
the cursor is positioned. The time can be formatted or deleted just as you had
physically typed it in.

2:

1:03:48:33PME ]

Select Date to add the current date to your label. Use the cursor keys to scroll
to the left of Date and press Enter. The Date Menu will appear offering 6 for-
mats (mm/dd/yy, dd/mm/yy, mm/dd//yyyy, dd/mm/yyyy, dd.mm.yy, dd.mm.yyyy).
Use the cursor keys to scroll to the left of the format you want and press Enter.

Date Menu
B mm/dd/yy _dd/mm/yy _

The current date will be added to the label where the cursor is positioned. The
date can be formatted or deleted just as you had physically typed it in.

2:

1:02/01/04 1 ]

Note: Do not confuse the TIme and Date options with the Stamp option. Time
and Date enters the current time/date into your label at the insertion point, once
entered they are now considered text by the printer (as if you typed them by
hand). The Stamp function will always use the current time clock at the
time of print job.

Select Stamp to have the current date and time (at the time of print) printed
vertically on the very edge of the label. Every time you press print a stamp with
the current date and time will be printed in ddhhmmMMMyy format. Use the cur-
sor keys to scroll to the left of Stamp and press Enter. This will turn Stamp on
and an asterisk will be displayed. To turn it off, press Enter again.

FI | e BaC ku p = Note: Using the stamp on tape supply sizes
] 0.50” and smaller is not recommended.
Marketing

1612-01Feb04

Select 24 Hour Mode causes time entered in the text of a label via the Time
option to be in 24 hour mode (i.e., 1 PM as 13). Use the cursor keys to scroll to
the left of 24 Hour Mode and press Enter. This will turn 24 Hour Mode on and
an asterisk will be displayed. To turn it off, press Enter again.
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PC Operations



Introduction

The K4100 will operate either standalone or as a PC printer. This new printer
will operate with Microsoft Windows 98, ME, 2000 or XP. Any standard windows
application such as Word, Excel or other programs can print to the K4100 via a
standard Windows printer driver.

Kroy also includes the Kroy Label Designer Software (KLDS) application with
your printer that contains easy to use, preformatted templates for your printer.

The communications between your printer and your PC are controlled by a win-
dows printer device driver.

The printer device drivers are located on the included software CD-ROM or cur-
rent drivers are available at www.kroy.com
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KLDS Software and Driver Installation

Installing the KLDS Software

Close all programs prior to installation. Insert the Kroy Label Designer into the
CD-ROM drive. On most systems the installation program will automatically
start. See the steps below to help you along with your setup.

SEEE I A

The InstallShield Wizard will appear and prepare to install.

Kroy Label Designer Setup will appear. Click Next to continue installation.
The License Agreement will appear: Click Yes.

Choose the Destination: the default will be C:\Program\Kroy Click Next.
You will then choose the Setup Type. The default is Typical and is
recommended for most users. Click Next.

Click Finish to complete.

Installing the Printer Drivers
The drivers for the KLDS will automatically setup. You will see the following
prompts once the software portion is complete.

1.
2.
3.
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Do you wish to install Kroy Printers. Click Yes.

The Kroy Printer Driver Setup will then appear. Click Next to continue.
You can now select to add your Kroy Label Printer under Setup Type.
Click Next to continue.

Select the mode of printer installation. Choose Automatic and connect the
printer to your PC using the serial cable. Turn the printer on.

Setup will then scan the COM ports on your system for the new printer,
Click Next.

Name your Kroy Printer and select it as your default label printer by
selecting Yes. Click Next.

Recommended Port Setting will appear and click OK.

Click Finish to complete.



KLDS Operation )

Creating a Label
Double click the KLDS Icon or go to your Start Menu\Programs\Kroy Label
Designer and select it. The main screen will appear.

1. Go to the Label Menu and select Label Setup. Click on the K4100 printer.
Click OK to verify.

Printer Type E

— Printer
EHK.225 Onling labeler

KT
56 K.3000-PC

A KE100

Ok, I Cancel |

2. Select the appropriate Supply Type, Size and Label Orientation that you
are using in your K4100.

K4100 Label Setup
Tape ITube I Die Eutl Wire Wrapl
— Width
[ 0500
[F0793"
B
— Length
& Automatic it I e
£ Fixed LLerigth I ifich
€ User defined Feed [T el [~ Cut Mark
r— Orientation
Iy
' Partrait % Landscape
(u] I Cancel I
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5.

A label template will appear on the Main Menu Screen. Select the Text
Tool “A” from the Main Tool Bar, click your left mouse button on the label
template and input text at the blinking cursor.

[ kroy Label Designer

Label Edt Attribute Object View Tools ‘Window Help

O|=(E| ble@x] Skl @] 8 @l | =ln]=(ls=n]w=]
[arial Hfie Fhoes Hfe £|u|[= =|= ‘ | 003.3 002.6 ‘

[ noname0L.kry

1 2 3 4 5 B 7 8
ml\‘\‘III‘\\\|\I\‘\II|\\I‘I\I‘\\Il\\\|\I\l\\I|I\\‘I\I‘\\\ll\\‘\l\l\\\'

After creating your label, click on the Print Icon from the top tool bar, or go
to the Label Menu and select Print. Select the number of copies and click
OK to print your label.

Frinter Type :  Krop K.4100 Label Printer
Paper: 1.0 Tape

Mumber of Copies : I

Printer Name Koy K4100 Label Printer =

Ok I Cancel |

The K4100 will then print your label.

For further assistance, go to the Help Menu of your KLDS Software.

44



< Downloading Fonts

Downloading a Font

The K4100 has the option of downloading fonts from the PC into your Font
Menu. Follow the steps below.

1. Connect the serial cable to the com port of choice and to your printer.
2. Go to the Start Menu of your PC and go to Settings and select Printers.
3. Right click on the K4100 driver and go to Properties.

? AL P
Open

Set as Default Printer

Printing Preferences...

Palise Printing
Cancel Al Documents

Sharing...
Use Printer Offline

Create Shorteut
Delete
Rename

4. Click on Control and go to Advance Options...

6% kroy K4100 Label Printer Properties
Geneal | Shaing | Pots | Advanced |
Securiy 1 Device Seftings Control
- Prifter

Get Sensor
valuss
Print Self Test Test

~ Piint C;

Print Density
Lighter 4| ] +| Darker
IV Advance to Cut Blade
I Pint Cut Marke Label Length
& irchies
Finedlengthlabel [ =
I” Fixed Length Lahel B

Advanced Optians

0K Cancel FEpl

5. Select Download Fonts from the Menu and click Update.

[advanced Printer Options

o High

Lo

Piint Speed

Piirt Offset Das
Vertical o 30 to +30 Pixsls

il [ 30to +30 Pirels

Select Printer update option

oK Cancel
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6. Go to the Font folder on the C drive of your PC and click OK.

Open 2]

File name: Folders: oK
e i [ ox ]

Cancel
= (0 Drwatson | —I

3 forms |

Hel
g meep ™ Readorly
B jave |

List files of type: Drives:

|Fonl File j I c: Local Disk j Metwork. .

7. Select the Font or Font Family of your choice and click OK.
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Dpen (2]

File name: Folders: [ o |

| srialbd tf ariabi tif arafitf = S thfont
Cancel

. = = _I

55 WINNT
L £ Fonis
aid ATHFold
aiialtH =] ot I~ FReadonly
ARIALNE.TTF |

ARIALNBLTTF =

Listfles of type: Drives.

Fant File o [= e LocalDisk =] Metwork

. The LCD Display of the printer will show the progress of the download using

the pound sign(#) across the bottom. The printer will show a receiving and an
updating display.

Updating...

HiHH#

Receiving...
i

. The download is now complete and you can find the font in your Font Menu.

Press the Delete key to accept the current Block font or use the left and right
cursor keys to move the cursor to the left of the font you want and press
Enter to select it.

Font Menu
B Block _times _arial




( Using Your Printer with Other PC Applications

You may also use other Windows applications to create labels with the K4100
printer. This is an example using Microsoft Word to create a label.

1. Click on the File menu and select Print.

Print 7]
[ Prinker
Marmne: q ¢4100 Label Prinker Propetties |
Status: Idle
Type: Krow K4100 Label Printer
where: oML ™ Print ta File
Comment:  Kroy Label Printer
~Page range ~Copie
o« all Number of copies: |1 3‘
e Currenk page £~ Selection
" Pages: I Hq V¥ Collate
P
Enter page numbers andfor page ranges
separated by commas. For example, 1,3,5-12

Zoam
Pages per sheet: |1 page 'l
I'Q" hages in range j Srale to paper size: INn Scaling 'l

Options. .. Close

Print what: IDocument j

Print:

2. Select the Kroy K4100 Label Printer in the drop down box and Click Close.
3. Click on the File Menu and select Page Setup.

Page Setup ﬂ E
Margins ~ Paper Size | Paper Source | Layout I
Faper size: revie
I 1.0 Tape 'l
Wiidth: 20 =
Height: 1" 3‘ —_—————
tienbabion————————

- ' Portrait

{* Landscape

Apply ta: Iwhnla document 'l

Default... [s]'q I Cancel |

4. Click on the Paper Size tab and select the supply type. This size should
match the size of the width on the supply cartridge currently installed in your
K4100 printer. Usually you will want Landscape orientation selected.
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5. Select the Margins tab and change the top, bottom, left, right, gutter, header
and footer to “0” or desired margin values. The default margins must be
changed since you are not printing to a full 8.5” x 11” page. For some media,
Word will want to “Fix” the margins based on the maximum printable area of
the media selected. In this case, 1” tape requires a 0.05” top and bottom
margin. Click on OK.

Page Setup
Margins | Paper Size I Paper Source | Layout I
Top: | | revt
EBoktom: ID‘DS" 3‘
Left: |0 3‘
Right: Io 3‘ [ —
Gutter: ID 3‘
romedge——————————
Header: ID 3‘
IRtz ID 3 Apply to: Iwhnle document 'l
r Mirrar margins Gutker position
™ 2 pages per sheet & Left  Tap
Default... oK I Cancel |

6. It is recommended to click on the View menu and select Page Layout mode.
7. A blank label template with a blinking cursor will appear on your PC monitor.
8. Enter the label text.

i3l Document1 - Microsoft Word
File Edit Yiew Insert Format Tools Table Window Help Adobe PDF

[
DEEE(8RY|iERS 0.
J

J

| e

Marmal + Tahoma - 28 v‘ B I U |§

Priting from Microsoff WORD

K4100 Desktop Label Printer

9. Select Print from the File menu. Make sure that the K4100 is selected and
Click OK to print the label. Note: When printing and the cartridge runs out of
tape, remove and install a new cartridge, and press Feed to continue printing.
DO NOT TURN OFF THE PRINTER.

To Save your label, go to the File menu and select Save. You can also save the
document as a template to start other label files.
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Appendix A: Maintaining Your Printer >

The printer requires no lubrication and only minimal maintenance. Occasional
cleaning of the exterior surfaces and regular cleaning of the printhead and
rollers are all that is required. This appendix explains how to clean these parts
of your printer.

Cleaning the Printhead and Rollers

The printhead and rollers should be cleaned after every cartridge Use isopropyl
90% alcohol on a soft cotton swab to remove adhesive buildup and tape and
ribbon residue. Make sure the alcohol has evaporated before loading a supply
cartridge.

Note: Avoid touching the surface of the printhead with your finger. Acids and oils
on your skin will damage the printhead.

A-1



Appendix B: System Messages

The following are system messages that the K4100 will display and an explana-
tion of each message.

Cannot Save
No Memory

Cartridge Empty

Font Size Too Big

Size Too Small

Font Error!

No Cartridge

No Files Found

Printer Too Hot

Printing...

B-1

(1) There is not enough memory to save your file.
Either delete unneeded files or simplify labels by
reducing the amount of text or the number of
formatting options they contain. (2) You tried to save
a file to drive B when it is write protected.

Cartridge supply is empty. Install a new cartridge.

The point size is too large for the number of lines
you have entered. Reduce the point size or select
fewer lines.

Auto size has calculated a size smaller than the minimum
size of 4 pt.

You entered the wrong number of characters for the
bar code. Check the requirements for the type of bar code
you are using and enter the correct number of characters.

Install a cartridge in order to print.

You selected Open or Delete but have no files
saved in memory. You must save files before you
can open or delete them.

The printer is too hot to print labels. Wait about five
minutes and then resume printing. This message
may also appear when the printer is used in an
ambient temperature below its minimum rated
operating temperature.

The printer is printing labels. No action required.



Appendix C: Troubleshooting

This appendix explains how to solve some common problems that may

arise when you are using the printer. If you are unable to correct the problem
contact your Dealer or Kroy Customer Service. In the United States, call
(800)347-5769; in Europe call +44-(0)118-986-5200.

Display stays black/blank
after printer is turned on

Printer does not print

Printed characters are not
formed properly

Printed characters have a

line through them and/or
voids

Printer isn't working
properly

Printer has locked up

e Adjust the LCD Contrast
* Make sure the AC Adapter is firmly
connected

¢ Ensure the lock/release knob is in the
locked position

* Check the supply cartridge and its position

¢ Check that the AC adapter and/or serial
cable is firmly connected

* Adjust the print density
* Clean the printhead and rollers

e Turn off printer and use a Kroy Cleaning
Kit (Part#255900) or use 90% or better
isopropyl alcohol on a cotton swab to
clean the printhead and rollers (See
Appendix A) for instructions.

* Reset the printer
e Turn the printer on and off

¢ Turn the printer on and off
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( Appendix D: Updating Firmware

Updating Firmware

Updates for firmware can be found at www.kroy.com. Go to support and click on
downloads.

1. Connect the serial cable to your Com port of choice and to your printer.

2. Download the updated file from our site.

3. Save the file to your PC.

4. Go to your Start Menu of your PC and go to Settings and select Printers.
5. Right click on the K4100 driver and go to Properties.

6. Click on Control and go to Advance Options...

&% Kroy K4100 Label Printer Properties (2] x]
Genetd | Shaing | Poits 1 Advanced |
Secuity | Devics Settings Control
~Printer

Get Sensor
values
Print Self Test Test

~Print ¢

Print Density
Lighter ] Tl | Daker
7 Advance to Cut Blade
™ Print Cut Marks Label Length
I™ Fited Length Label - :: ::f“e

Advanced Options

oK Cancel Aoy

7. Select Download Firmware from the menu and click Update.

Advanced Printer Dptions

) Hidh

Ly

Fiint $peed
Fiint Offset Do
Weitical 0 30 to +30 Pixels

P Ofet [T 3010430 Piele

Select Prirter update option

Update
Dowrload Fort
Erase &l Fonts
List Fonts
Dclete Font:

Cancel

8. A warning will appear below and click Yes to continue.

K4100 Firmware Update WARNING

& Do not update the firmware unless advised to do so by Kroy Technical Support, This may cause permanent damage to your printer,

Do wou want ko continue?

‘es Mo




9. Select the firmware file and click Open.

Open
Look in: [[f] Deskton H = 2 crE-

My Documents
Wy Computer

|1 shortcut to krish

File name: Jk4100-1E04BIT rom B Open |
Files of type:. [RoM Fie = Cancel |

™ Open as read-only

10. The printer will then update the file.

advanced Printer Options

g i

Speed
R

Phint Dffset T
Vertical 0 30 to +30 Pixels

E’DW,.‘IS:[:[ 0 -30 to +30 Piveds

Seleet Prinier update oplion

Update

Frinter is Updating file. Please wait..

The LCD Display will show the progress of the download using the pound

sign(#) across the bottom. The printer will show a receiving and an updating

display.
Receiving... Updating...
HHtH#H# Hit##H#

9. The download is now complete.

K4100 Firmware Update X

Firmware update done.
Flease switch on the printer
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C Appendix E: Using Accent Characters

K4100 has a variety of international characters and symbols found in Blue on
the keypad. Use the Alt key + the accent character and/or symbol to print out
these special accent characters.

In our example, we will use the ~ accent character and add it to the letter “i”
in “Factoria” (Factory).

The “” in “Factoria” must be accented. To do this, you will hold down the Alt +
key on the keypad. This activates the accent character. You will then press
the letter “I” on the keypad. The printer will then display the accented character
in the text of the label.

1:Factoria _
2:

Accent Character Guide

A aAeEiloOuU

~ aAnNoO
aAeEiloOuUyY
aAeEiloOuU
aAeEiloOuUyY




Appendix F: Using the Character Map

The K4100 has the capability to accept code to print characters not found on
the keyboard. To use the character map, the Extended Mode must be on.To
turn the Extended Mode on press the Alt and Space Bar together. To turn this
mode off, press the Alt and Space Bar together again. See the character set
below for ASCII codes to assist you.

To enter characters in extended mode, enter the 4 digit code shown in the table
below. Most of the characters will be properly displayed on the LCD. For some
characters, a solid block place holder will display on the LCD, but the selected
character will print on the label.

ASCII Code | Character ASCIl Code | Character ASCII Code | Character
0123 { 0204 i 0231 C
0124 | 0205 i 0232 &
0125 } 0206 ) 0233 é
0126 ~ 0207 i 0234 é
0140 E 0208 1) 0235 é
0156 e 0209 N 0236 i
0159 Y 0210 0 0237 i
0162 ¢ 0211 o} 0238 i
0163 £ 0212 0 0239 i
0165 ¥ 0213 o] 0240 o)
0168 h 0214 o) 0241 fi
0176 ° 0215 x 0242 o]
0177 + 0216 1} 0243 o]
0180 ’ 0217 U 0244 )
0191 é 0218 U 0245 0
0192 A 0219 0 0246 o)
0193 A 0220 U 0247 +
0194 A 0221 v 0248 o
0195 A 0222 p 0249 U
0196 A 0223 R 0250 a
0197 A 0224 3 0251 o}
0198 £ 0225 4 0252 v}
0199 C 0226 3 0253 y
0200 E 0227 5 0254 b
0201 E 0228 5 0255 y
0202 E 0229 3
0203 E 0230 ®
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